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	NCC
Sirsi Database Cleanup Agenda
Revised: April 16, 2012

	General Information

When viewing reports generated from the INFOhio tab, you should uncheck both View log and Format report. For any reports NOT on the INFOhio tab, you will uncheck View log only. With the exception of the inventory variety, reports will only remain in your Finished Reports for 30 days; if appropriate, save reports to your computer for later reference.
Tip: By running reports to assist with cleanup, staff can easily copy/paste from the MS Word report to Workflows by toggling between the two applications. To do so, have only those two applications open and hold down the [Alt] key + [Tab] key to toggle between the two.


	Agenda
	Activity
	Notes

	PATRON RECORDS


	
	Reminder: NCC deletes patrons in batch per your request. These reports will help you identify patrons that NCC could not delete due to open transactions.

	Note: For individuals comfortable using MS Excel, you may wish to choose the alternate method listed on page 3 under Spreadsheet Option.
	
	

	1a) Removing obsolete patrons for schools that enter the patron grade/expiry date
Generate a list of inactive/obsolete patrons to remove.


	1a) INFOhio tab ( PAT : List Users

USER OPTIONS TAB

User Status: Inactive

USER SELECTION TAB
Library: BLDG code

Choose one:

User profile: STUDENT# 

or Grade: ##

SORTING TAB

Suggestion: library/grade/name

OUTPUT OPTIONS TAB

Long; RTF; Landscape; Normal
( Expiration Date
	Be sure to enter a profile or grade, otherwise the Sirsi ‘default’ users will be included; include or exclude FACULTY.



	1b) Removing obsolete patrons for schools that do NOT enter grade and/or expiry date
Generate a list of inactive/obsolete patrons to remove.


	1b) INFOhio tab ( PAT : List Users

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB
Library: BLDG code

Choose one:

User profile: STUDENT# 

or Grade: ## (or, use the grade UNGRADED if no grades are entered)

Date created: use gadget to select appropriate ‘before’ date (e.g. <08/01/2006)

SORTING TAB

Suggestion: library/grade/name

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Landscape; Normal
	Be sure to enter a profile or grade, otherwise the Sirsi ‘default’ users will be included; include or exclude FACULTY.

	2) Removing duplicate patrons 

Generate a patron list, sorted by name, to identify duplicate patrons. 
* You may only wish to run this report if you have been noticing a large number of duplicate patrons in your database.
	2) INFOhio tab ( PAT : List Users

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB
Library: BLDG code

Choose one:

User profile: STUDENT# 

or Grade: ## 

SORTING TAB

library/name/barcode

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Landscape; Normal

Scroll through the finished report to identify duplicate patron records.
	When viewing the finished report, you need to scroll through, looking for duplicate names. Typically, duplicate records are created when a patron’s ID changes, but the old account can’t be deleted due to open transactions. If duplicate patron records are found, copy the barcode from the new account, delete the new account, and update the old account with the new barcode number.
Be sure to enter profile or grade, otherwise the Sirsi ‘default’ users will be included; include or exclude FACULTY.
Sort is important!


	3) Patrons entered at DISTRICT

Generate a list of patrons accidentally entered at the DISTRICT building.


	3) INFOhio tab ( PAT : List Users

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB
Library: DISTRICT

SORTING TAB

library/barcode

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Landscape; Normal 


	!! IMPORTANT– IMPORTANT !!

There are default ‘system’ users entered into the database, with alpha barcodes instead of numeric. DO NOT DELETE THESE USERS or there will be serious consequences to your database. Most, but perhaps not all of these users will have “DO NOT DELETE” in the username. If you are uncertain whether or not it is safe to delete a user entered at DISTRICT, contact LNOCA_SUPPORT.


	4) Patrons with invalid IDs

Generate a patron list to identify invalid patron IDs. 
* You may only wish to run this report if you have been noticing a large number of patrons with invalid IDs in your database.
	4) INFOhio tab ( PAT: List Users

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB
Library: BLDG code

Choose one:

User profile: STUDENT# 

or Grade: ##

SORTING TAB

library/barcode

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Landscape; Normal 


	Be sure to enter profile or grade, otherwise the Sirsi ‘default’ users will be included (see warning directly above).
Sort is important!



	Alternate: Spreadsheet Option 

Generate a single patron list in spreadsheet format that can be used to identify the same cleanup as in steps 1a, 2, and 4 above.

Alt-1a) Removing obsolete patrons for schools that enter the patron grade/expiry date
Alt-2) Removing duplicate patrons 

Alt-4) Patrons with invalid IDs


	ITC Custom tab (LN: Student List Excel

Run the report, leaving the default parameters. From Finished Reports, choose to Print and uncheck Print Log and Format Report. 
Alt-1a) Press [Ctrl]+A to select the entire spreadsheet. Go to Data(Sort and choose to sort by Ex. Date on Value.
Alt-2) If you have MS Word 2007 or higher, highlight the name column by clicking the ‘B’ column header. From the Home tab, select Conditional Formatting(Highlight Cell Rules(Duplicate Values; click OK. Press [Ctrl]+A to select the entire spreadsheet. Go to Data(Sort and choose to sort by Name on cell color. If found, any duplicate values will be at the bottom of the spreadsheet.
If you have MS Word 2003, press [Ctrl]+A to select the entire spreadsheet. Go to Data(Sort and choose to sort by Name. Scroll through the list, keeping an eye out for duplicate entries.
Alt-4) Right click the column A header and choose Format Cells. Choose a Category of number with 2 decimal places. Press [Ctrl]+A to select the entire spreadsheet. Go to Data(Sort and choose to sort by Barcode on Value. If found, invalid barcodes will appear at the top and/or bottom of the spreadsheet.

	

	TRANSACTIONS

	When running overdue reports, it is helpful to understand the differences between the User Selection tab, Checkout Selection tab, and Item Selection tab.
· User Selection Tab: The library field on this tab refers to the library to which the user is assigned.
· Checkout Selection Tab: The library field on this tab refers to the library associated with the account of the staff member who is logged in. Provided the staff member is correctly logged on (with an account appropriate to the physical location), this field will reflect the building at which the actual checkout/transaction occurred.
· Item Selection Tab: The library field on this tab refers to the library to which the item belongs.

Based upon the above explanation of the User, Checkout, and Item selection tabs, there are many different ways to run overdue reports depending on the information you desire. The following reports are just two examples.


	1) Overdue Desklist (brief)
Generate a report of all users at your library who checked out items belonging to your library where those items were due prior to 9/1/2011.


	1) INFOhio tab ( CIR : Overdues and Notices 

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB

Library: Your BLDG code

Choose one:

User profile: STUDENT# 

or Grade: ##
CHECKOUT SELECTION TAB

Date due: <09/01/2010 (or your choice)
ITEM SELECTION TAB
Library: Your BLDG code

SORTING TAB

Select from drop down box.

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Portrait; Normal

Recommend: uncheck Total Bills and Charges and Start New Page on Sort Key
	Your choice whether or not you include or exclude FACULTY. 
General Options:

· Explain Unpaid Bills will include users who may not have overdues; they just have bills for lost items. 


	2) Overdue Desklist (brief)
Generate a report of users at your library (both students and faculty) who have overdue/lost items from any library other than your own.  
	2) INFOhio tab ( CIR : Overdues and Notices

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB

Library: Your BLDG code

ITEM SELECTION TAB

Library: Use gadget to exclude your library

SORTING CRITERIA TAB

Select from drop down box.

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Portrait; Normal

Uncheck ‘Start New Page on Sort Key’
Uncheck ‘Hide Inactive Transactions’
	


	3) Holds

Generate a report of users with holds.

	3) INFOhio tab ( PAT: List Users

USER OPTIONS TAB

User Status: Both

USER SELECTION TAB
Library: BLDG code

Choose one (if desired):

User profile: STUDENT# 

or Grade: ##

Number of Holds: >0

SORTING TAB

Your choice

OUTPUT OPTIONS TAB

Keep defaults: Brief; RTF; Landscape; Normal 
	A hold is considered a transaction on a patron’s account. As such, you will not be able to delete a patron’s record until all holds are removed. 

For instructions on removing holds, please see section 8.4 of the online Java manual.

	4a) Identifying Transits via Pending Transits Wizard

	4a) Go to the Special Circulation wizard group ( Pending Transits to see transits for your building. Click the “schoolhouse” helper to view transits for other buildings.
	For information on receiving items in transit, please see section 7.8 of the online Java manual.

	4b) Identifying Transits via List Transits Report
Generate a report of items in transit.

	4b) Circulation tab ( List Transits

TRANSIT SELECTION TAB
Unless you have a very large district, you may not want to complete any of the library fields. That way, the report will include both everything on its way to or from your library. Or, you can limit the report by destination library, starting library, or (owning) library.

SORTING TAB
Your choice

NOTE: When viewing, uncheck View Log ONLY.

TIP: Use the Edit(Find tool to search for every occurrence of your library code.
	For information on receiving items in transit, please see section 7.8 of the online Java manual.




	ITEMS
	
	

	1) Identifying XX Call Numbers via the Call Number/Item Maintenance Wizard


	1) From the Call Number/Item Maintenance wizard, complete the fields as follows and then click Search:

Search for: XX

Index: Call Number

Library: BLDG code (you must select a single bldg)
Type: Browse

	If you have a large number of XX call numbers or if you wish to identify XX call numbers for multiple buildings at one time, you can instead run two reports to obtain the information: 

· CAT: Shelflist Report 

· Titles with no Copies 

	2) Titles with no copies
Generate a report of titles to which no copies are attached. 

	2) All Titles tab ( List Titles with No Copies
CALL NUMBER SELECTION TAB

Library: BLDG Code

SORTING TAB
Sorted by: Call number

NOTE: When viewing, uncheck View Log ONLY.
	This report will include XX call numbers as well as valid call numbers that were not deleted when the last copy was removed.

	3) Identifying brief records via the Item Search/Display Wizard

	From the Item Search/Display wizard, complete the fields as follows and then click Search:

Search for: brief record

Index: General

Library: BLDG code

Type: Keyword
	This will only work if you have entered ‘brief record’ in the 989 field.


INFOhio CAT: Shelflist Report
Certain database cleanup can only be identified by running the INFOhio CAT: Shelflist report in spreadsheet format. In addition, by using Excel, much time can be saved by running one all-encompassing spreadsheet report and then sorting that report on the desired field (one at a time). 
1. Go to the Report Session wizard and use the gadget change your application to print reports to Microsoft Excel; typically, the filepath will be: C:\Program Files\Microsoft Office\OFFICE##\EXCEL.EXE

2. Setup/Schedule the CAT: Shelflist report from the INFOhio report tab.

3. On the Item Selection tab, enter your building code in the Library field.

4. On the Output Options tab, choose the following:

· Type: Spreadsheet; Plain Text (other settings don’t apply)

· Long/Spreadsheet Options - Bibliographic Field Selections: ( ISBN

· Long/Spreadsheet Options – Other Field Selections: check off all of the following (plus any others of particular interest to you):

( Barcode

( Call Number

( Status
( Title


( Item Group

( Material Type
( Last Activity Date
( Last Checkout Date
( Total Number of Checkouts
( Author

( Price


( Pub. Year

5. Run the report; from your Finished Reports window, click the Print button; uncheck both Print Log and Format Report; the report should open in Excel.

6. Select the entire report either by holding down the [Ctrl] key + A, or by clicking in the ‘blank’ cell that is to the left of Column A and above Row 1. 

7. From the Data menu, choose Sort and choose to ‘sort by’ the field(s) of your choice:
· Call Numbers (to check formatting errors in the call number prefix and/or identify ‘XX’ call numbers)

· Barcode (to check for invalid item IDs)

· Status (in particular, to check for inactive statuses such as LOST, MISSING, REPAIR, etc.)

· Date last checked out / last activity date (to be used in correlation with checking on inactive statuses, or for the purpose of weeding)

· Price (to identify items with no price, or with obviously incorrect prices…which will skew your Value of Collection report data)

· ISBN (to identify items with no ISBN, or with obviously incorrect ISBNs; the ISBN is used to display added content in the OPAC)

· Item Group (to identify items within item groups your library doesn’t use, or for items entered in the BOOK item group, which should not be used)

· Item Group / Material type (by sorting first by item group and then by material type, you can check whether the material type is appropriately assigned; e.g. you could identify DVDs with a material type of BOOK)
· Total number of checkouts that have occurred in Sirsi only (for the purposes of weeding…or for checking on the most popular titles)

· Publication Year (to check for errors that will skew the Age of Collection report data)
8. Optional: To change the barcodes to a readable 14-digit format, click the column A header; go to the Format menu(Cells; on the Number tab, change the Category to Number and the Decimal places to 0; click OK.
INFOhio CAT: Shelflist report instructions using Microsoft Word
Note: Any ‘grayed’ goals below can be accomplished using the above Excel method. For the following, your filepath to view reports should be set to MS Word.
	Goal
	Item Selection Tab
	Sorting Tab
	Output Options Tab
	“Other” tab and/or special notes

	Generate a report of ‘long’ lost, missing, and checkedout items. 
	Library: BLDG code

Current Status: use gadget to select: CHECKEDOUT, all 4 ‘LOST’ statuses, & MISSING
Date last checked out: <09/01/2008 (or your choice) 
	Call number/…


	Type:

Brief; RTF; Landscape; Normal

Brief options: 

( Checkout date


	Note: By sorting on call number, you’ll easily be able to check your shelves for the items before taking further action.

	Generate a report of XX call numbers with copies 
	Library: BLDG code

	Your choice
	Type: 

Brief; RTF; Landscape; Normal
	Call Number Selection tab:
Call number range: >X<XXX 

	Generate a report for a specific item status/statuses
	Library: BLDG code

Current Status: your choice (MISSING, LOST, etc)
	Your choice
	Type: 
Long; RTF; Landscape: Normal

Long/Spreadsheet Options:
( Last activity date

( Last checkout date
	Note: if generating a report for LOST items, choose all 4 ‘LOST’ statuses: LOST, LOST-ASSUM, LOST-CLAIM, and LOST-PAID.

	Generate a list of items without prices
	Library: BLDG code

Price: =0.00 
	Your choice
	Type: 

Brief; RTF; Landscape; Normal
	


	Goal
	Item Selection Tab
	Sorting Tab
	Output Options Tab
	“Other” tab and/or special notes

	Generate a list of items that have not been checked out since a particular time 
	Library: BLDG code

Date last checked out: use gadget to enter a date before; e.g. <8/1/2005
	Your choice
	Type:

Long; RTF; Landscape; Normal

Long/Spreadsheet Options:

( Last checkout date
	Note: Sirsi can only report checkouts that occurred in Sirsi (multiLIS checkouts will not be reported).

	Generate a list of items based on how many times they have been checked out (for weeding)
	Library: BLDG code

Total number of checkouts: use gadget to enter your choice (e.g. for items w/no checkouts, enter: =0)
	Your choice
	Type: 

Brief; RTF; Landscape; Normal


	

	Generate a list of items sorted by publication year (to check for items to be corrected or weeded)
	Library: BLDG code
	pubyear/…
	Type:

Brief; RTF; Landscape; Normal

Brief Options:

Publication Year
	Check at the beginning and end of the report for titles without a publication year and titles with incorrect publication years.

	Generate a report to identify items with invalid IDs
	Library: BLDG code
	Item ID
	Type:

Brief; RTF; Landscape; Normal


	Check at the beginning and very end of the report for items that do not match the INFOhio barcode format. 

	Generate a report to check material types against item groups
	Library: BLDG code
	library/itemgroup..
	Type:

Long; RTF; Landscape; Normal

Long/Spreadsheet Options:

For ease in viewing, only check off: 
( Barcode


( Title


( Item Group


( Material Type
	Note: by using the Excel spreadsheet option provided in the previous section, it will be much easier to view/sort the item groups with the material type.

	Generate a list of items with an item group of BOOK
	Library: BLDG code

Item group: BOOK
	Your choice
	Type:

Brief; RTF; Landscape; Normal
	The BOOK item group is a Sirsi default item group, which should not be assigned to any items.

	Generate a list of items entered at the DISTRICT building
	Library: DISTRICT
	Your choice
	Type:

Brief; RTF; Landscape; Normal
	The DISTRICT building code is a Sirsi default building code, which should not be assigned to any items.

	Generate a report of brief records (provided you have entered ‘brief record’ in the 989 field)
	Library: BLDG code


	Your choice
	Type:

Brief; RTF; Landscape; Normal
	Search String tab:

In the search string field, type: brief record. Note: If you have been consistent in your letter case (upper/lower), use that same formatting here.

	Generate a report to identify errors in the formatting of the call number prefix/suffix (including XX call numbers)
	Library: BLDG code  


	Call number/…
	Type:

Brief; RTF; Landscape; Normal
	


Miscellaneous Cleanup:
· Remove unused report templates and/or scheduled reports that are no longer useful
· Remove unneeded inventory reports from the finished reports list
Tips and Tricks:
· Global Item Modify: Using the Global Item Modify wizard is an efficient way to do the following:
· move items to the DISCARD location (for NCC to delete in batch); see instructions at: http://www.lnoca.org/departments/library/files/handbook/H_BatchModify.doc
· change the item group, material type, funding source, item library, and or price for a set of items

· LBL: Item Label report: Print barcode labels for groups of items you need to modify/delete. For example, lost/missing items, items with no price, etc. Depending on the appropriate course of action, you can then scan those barcodes into the Check In wizard or Global Item Modify wizard; or, you can use the Call Number/Item Maintenance wizard to quickly retrieve those records by changing your properties to search by item ID. 
· Deleting Items: If you intend on deleting all items within the same current status (LOST, MISSING, DISCARD, etc), you may wish to run the CAS: Value of Collection report based on that current status to obtain the total value of those items. 
In order to assist you, NCC can:
· batch delete items based on select statuses (e.g. NCC can batch delete all MISSING items, but not always LOST items (since the latter have transactions associated with them)

· batch delete all items within an item group
· batch modify call number prefixes (e.g. if you want to change/remove large numbers of identical prefixes)

· run a procedure to report the number of times each report template was used this year and last year so that users can identify which templates are no longer needed and should be removed 

· run a procedure to check-in very old checkouts so the items can be properly identified as LOST or MISSING and the associated patrons can be removed, if desired 

· run a procedure to identify invalid user or item barcodes
· run a procedure to determine the barcodes currently in use within your district, a particular building, a particular item  group,  etc.

Reference Materials:

· Database Cleanup Agenda: http://www.lnoca.org/departments/library/files/handbook/H_DB_clean.doc
· Global Copy Edit: http://www.lnoca.org/departments/library/files/handbook/H_BatchModify.doc
· Reporting Transits: http://www.lnoca.org/departments/library/files/handbook/H_ILL_rpt.doc
· Resolving Transits: http://www.lnoca.org/departments/library/files/handbook/H_ILL_troubles.doc
· From the Java Manual: http://www.infohio.org/javamanual
· Transfer Item: http://www.infohio.org/Documents/SirsiManual/SirsiJava/S11.3TransferItem.doc

· Remove User Holds: http://www.infohio.org/Documents/SirsiManual/SirsiJava/S9.4RemoveUserHold.doc

· Remove User: http://www.infohio.org/Documents/SirsiManual/SirsiJava/S4.5RemoveUser.doc

· Remove Item: http://www.infohio.org/Documents/SirsiManual/SirsiJava/S11.4RemoveItem.doc

· Receive Items in Transit: http://www.infohio.org/Documents/SirsiManual/SirsiJava/S7.8ReceiveItemsIntransit.doc

